"FI"
Electronic Fuel Injection System

Electronic Control Unit Instruction Manual
"Introduction"

Thank you very much for purchasing the "Fi" system ECU (Electronic Control Unit).
"Fi" is a fuel injection system for small displacement motorcycle, and this system is not a simplified but a full functional system, as well as it of large displacement Motorcycle. ECU can detect various states of engine by various sensors and control the optimal volume of fuel. Furthermore, if you use this system, it is possible to set up almost all the parameters about Injection with the personal computer linked to ECU. Almost all parameters can be set up by the full range. Of course, you can use a setup which FC design prepares and can also do a setup from zero.

Please read notes of the following page before beginning to use this system.

If you have any questions about this system or instruction manual, please contact us.

**FC Design**
2-1-48-101, Honmachi, Fuchucho, Akigun, Hiroshima, Japan post code 735-0006
Tel +81-82-287-0211
Fax +81-82-287-0212
http://www.fc-design.com
E-mail: info@fc-design.com
"Attention"

(1) This product is only for racing use. Therefore, we recommend strongly that you use this system in safe places which can respond to the emergency engine stole by the mistaken arrangement etc., such as a circuit.

(2) Please install controller in the place which avoided raindrops, splash, etc.

(3) Do not install a controller in places which become high temperature extremely, such as near an exhaust pipe.

(4) When you arrange setting or check this system with engine started, we recommend you to go in a well ventilated place strongly.

(5) Since high pressure has started the fuel line, please check pipe and hose to keep a performance and safety. Moreover, please be sure to check before a running.

(6) In order to avoid the accident, please decompress the pressure in fuel line before decompose a fuel pipe system.

(7) Do not use this product other than the original purpose.

(8) You shall not about this system (Hardware, Software, Documents, etc.):
   (a) Copy, in whole or in part.
   (b) Modify
   (c) Reverse engineering of the composition parts of this product containing software.
      (Reverse compile or reverse assemble the PC software and ECU firmware)
   (d) Transfer software, a document, and CD-ROM independently.

(9) When you use this system combining the products of the other company, we do not take responsibility for other company's products.

(10) If you have troubles and accidents by using this product without observing notes above, we will not take no compensation and responsibility.

![Warning](image1)

**Warning**

- **Fire strict prohibition in disassembly**
- **Fuel pressure over 4kgf/cm²**
- **Avoid exposure to water**

![Danger](image2)

**Danger**

- **Avoid static electricity and electric shock**

![Caution](image3)

**Caution**

- **Avoid static electricity and electric shock**

"When you connect ECU to the system harness..."

(1) After removing terminal of vehicle wiring which are connected to the battery, connect system harness to wiring of vehicles, attach or remove ECU to system harness.

(2) When ECU is connected for the first time, please look at the lamp display of ECU well. Please turn off a switch promptly, and check the polarity of a power supply, and connection, when a power supply lamp does not light up.

(3) When you disconnect a coupler from system harness, be careful not to cut the wire of it.
"Content"

(1) Product outline

(a) ECU exterior p1-1
(b) Fuel Injection Control p1-3
(c) Other Controls p1-6
(d) Other Parts of System p1-7
(e) Dial Controller p1-9
(f) Lamp Display Function p1-11

(2) Tutorial of PC software [SWB]

(a) How to Install p2-1
(b) Outline of "SWB" p2-2
(c) Start and Exit p2-5
(d) How to Set-up the Settings -- "Map" p2-6
(e) Read Settings from ECU p2-7
(f) Read Settings from the File p2-9
(g) Save Settings to the File p2-10
(h) Edit "Basic Injection Time" Settings
   (A) "Changing a value for every point" p2-11
   (B) "Multiplying "Gain" to every domain" p2-12
   (C) example p2-14
   (D) Set the Multiple rate every R.P.M. p2-15
(i) Enable / Disable of Compensations. p2-18
(j) "Fuel Pump Drive" setting. p2-19
(k) Rev. limiter & Indicator. p2-21
(l) "Compensation" setting.
   How to change. p2-22
   Warm-Up Compensation p2-23
   Start-Up Compensation p2-24
   Start-Up Injection Time p2-24
   Asynchronous Injection p2-24
   Fuel Cut Control
   Accelerate Compensation (for *D-Jetronic only)p2-25
(m) Sending "Setting" to ECU. p2-26
(n) Data Monitoring Window p2-27

The chapters shown in a red character are going to translate into English now.
(3) configure and sensor adjustment
   (a) Setting of close values and full open value of throttle sensor . . . p3-1
   (b) Threshold of Idle Throttle . . . p3-3
   (c) Adjust "Map" to "Injector Capacity" & "Engine Displacement" . . . p3-4

(4) To start "Map Setting" --Hint of work
   (a) "constant" load(throttle) setting . . . p4-1
   (b) "(rapid)Change Thrpttle" setting . . . p4-3
   < Asynchronous Injection>

(5) Appendix.
   (a) spec . . . p5-2

* Microsoft and Windows are registered trademarks in the United States and other countries of Microsoft Corporation(USA).

The chapters shown in a red character are going to translate into English now.
(1) "Product Outline"

(a) ECU exterior

ECU8P, ECU10P: In case a coupler is connected, a main part is pushed in by hand until sound "Click". When disconnecting, couplers are pulled, after pushing in the button of the coupler upper part.

**Be careful not to cut the wire of it.**

A communication cable connects only the cases at the time of an setting arrangement etc. with PC serial port by the cable contained in this products. In addition, it can attach also in the state of power supply ON, or can remove.
The lamp on the right-hand side of a photograph is a lamp of the red which performs a system information display. It is the display of an injection timing signal input, a system error, etc. Display function is almost same as dial controller lamp. (except a shift-up indicator function)

* Please read Chapter (f) "Lamp Display Function" for details..

The lamp on the left-hand side of a photograph is red lamp, ECU power supply indicator, when the power supply is on.

When IG key-off, ECU power OFF is postponed only for between the change check of arrangement data. In this period an ECU power are supplied from "Backup" wire of system harness which is connected to battery plus terminal. After that, ECU is turned off and holding data does not need power supply.
(b) Fuel Injection Control

The volume of fuel is controlled in time of ON period of injector.

\[ \text{Volume (cc)} = \frac{\text{Injector flow rate (cc/min)}}{60 \text{ (sec)}} \times \text{Injector ON period (sec)} \]

By the text after this, time of ON period of injector is called injection time. You can set injection time to 32msec at the maximum in each cycle. Injection time is calculated as follows.

\[ \text{Injection time (Ti)} \]
\[ = \text{Basic Time (Td)} \times \text{Startup Compensation} \times \text{Warm-up Compensation} \times \text{*Acceleration Compensation} \]
\[ + \text{Injector Dead time} \]

*Speed-Density System Only (*D-Jetronic version)

You can set these compensation values to "1.0" quickly with each enable/disable property on software. The lower figure expresses control of injection.

The outline of each control is explained in the following page.

**"D-Jetronic" is the registered trademark of Bosh AG
"Basic Injection Time"

**Throttle - Speed Control Version (Alpha-N)**

There is a map of injection time to the volume of intake air determined with two parameters, the open angle of throttle and engine speed, in ECU, and the "basic injection time" is determined with reference to the map. Even when the open angle of throttle and engine rotation speed take the value between axes, the injection time is computed by complement calculation.

An injection map can be edited from PC.

The axis of a map can be set up to 31 at the maximum to each of the open angle of throttle, and engine rotation speed. It is possible to set up arbitrary number of the axis to the arbitrary axis value in this range.

**Speed - Density Control Version ("D-Jetronic")**

There is a map of injection time to the volume of intake air determined with two parameters, intake manifold pressure and engine speed, in ECU, and the "basic injection time" is determined with reference to the map. Other control function is same as "Throttle-Speed Control".

This Control Method is best for super charged engine (turbo, etc.). In a super charged engine version, intake manifold pressure is detected to about 2 kg/cm² (1600 mm Hg).

(Normal version sensor is up to 800 mm Hg.)

* Accelerate Compensation is only for "D-Jetronic".

See Details (Section)

"D-Jetronic" is the registered trademark of Bosch AG
"Compensation"

Please read Chapter 2 for details.

**Warm-up Compensation**
*(Engine Temperature Compensation)*

This is compensating the lack of fuel evaporation and increase in volume of air filled in engine when engine has got cold.

**Start up compensation**

This is compensation which increases fuel after starting of engine until it carries out stable rotation.

**Start up injection time**

This is not a compensation value. It is injection time which will be injected in a period until it becomes a rotation speed stable.

**Asynchronous injection time**

Asynchronous injection is the function to perform compensation injection, when change of the intake air volume rapidly between the timings of synchronous injection.

**Fuel Cut Control**

In engine rotation speed over idle speed, fuel injection is stopped at idle throttle position. This functions also as an idol R.P.M. limiter.

**Accelerate Compensation** *(for *D-Jetronic only )*

This function correct a gap of the air / fuel ratio resulting from change of the intake pressure by acceleration or slowdown. It differs from the asynchronous injection which performs compensation injection temporarily that the volume of synchronous injection is increased or decreased between a certain set-up cycles.

"*D-Jetronic" is the registered trademark of Bosh AG
(c) Other Controls

"Pump Control"

The pressure of fuel is required for fuel injection. The in-line pump is controlled from ECU. In order to suppress useless consumption of a battery, intermittence according to required quantity is driven in the low rotation speed domain. The PWM drive is performed in the high rotation speed domain. It is possible to perform a setup of a drive from PC connected with ECU.

*ECU is not measuring the pressure of fuel. Please set up the parameter of ECU, looking at the pressure gauge attached to this products("Fi System set") so that required pressure may be obtained.

"Revolution Speed Limitter"

Fuel injection will be stopped if it becomes more than the set-up rotation speed. You can set it as arbitrary values from PC.

"Shift-Up Indicator"

The lamp with which the dial controller is equipped is turned on when it becomes more than arbitrary rotation speed. You can use it as a shift-up indicator.

*Option "Extended Injector control"

ECU also Controls Extend Injector for Oxygen injection system(Option). Please read the description of an oxygen injection system for details.

Please read Chapter 2 for details.
"Throttle body"

It is the throttle of a rotary valve. Injector, the throttle sensor, and the extraction mouth of intake pressure are attached to this.

"Signal interface unit"

This is the unit which makes the signal for injection from an ignition signal. This makes 1 time of a signal to two rotations of a crank.

"Temperature sensor"

The element for temperature detection is enclosed. It attaches in the cylinder side and the temperature of engine is detected.

"Dial Controller"

There are a dial which changes fuel injection time by one point temporarily, and a lamp which displays information in this. The chapter(e) explains for details.

"Fuel pump"

It is the in line pump for fuel driven on the voltage of 12V. The maximum output pressure is about 4 kgf/cm². The rated pressure of a system is 2.5 kgf/cm².
"Fuel pressure regulator"

It attaches in the fuel piping. This keeps the pressure of fuel constant.

"Accumulator"

This suppresses change of the output pressure of a pump by which an intermittent drive is carried out.

"Pressure sensor"

This detects the pressure of intake manifold. This sensor is only for "D-Jetronic system"

Sensor of version for supercharged engine
maximum : 1600mmHg (about 2kg/cm²)

Sensor of version for normal engine
maximum : 800mmHg (about 1kg/cm²)
(e) Dial Controller

"Function"

The "Dial Controller" is equipped with the dial which can increase or decrease injection time (whole map) temporarily, and the lamp which displays the information on ECU. It is possible to change injection time in the quite big range from 0.1 times to 1.9 times by the dial. A left rotation side is the direction of "rich" (upper scale 1-1.9 time), and a right rotation side is the direction of "lean" (lower scale 0.1-1 time). The minimum scale is 0.1.

In addition, since a setup of the range corresponding to a dial can be changed into arbitrary values from PC, adjustment width can be made large (for example, 0.05 time -4 time etc.), or it can be narrowed (for example, 0.5 times to 1.5 times etc.).

Please read Chapter (f) for "Lamp Display Function" details.
The example of use of a “Dial Controller”

Although, as for a dial controller, only a primitive setup of changing the whole can be performed, according to a way, it can use for the arrangement of a map quite conveniently. The following is an example of use of a dial.

(1) After attachment "Fi", when starting the engine for the first time, the engine can be started correcting a gap of the injection time of the original map with a dial. You put engine into operation, turning a dial and changing various injection time first. You look for a dial position so that engine may carry out stable rotation. After engine starts, you look for the position which engine strats misfire by turning a dial. Thereby, you can know the “Rich” side limit of the injection time, and the limit by the side of “Lean”. You read the scale of a position which turned to the “Rich” side a little from the middle of those dial positions. You can know that that is the best injection time near an idol. It is good for you to adjust the injection time of the idol area of a map with this value of a dial.

(2) It may be good to apply the multiple value which corrected an idol’s injection time also to the whole map.

(3) It is very difficult to touch a dial during a runnig, so you turn a dial before running and you run at a certain degree of throttle. You run in the some dial position and read the dial position which becomes the largest power. And you correct the injection time of domain, which you check on the map.

(4) When decomposing a fuel piping system, it enables you to lower fuel pressure simply by continuing operating engine, with a pump suspended. At this time, it can lower to remarkable low pressure by consumption of fuel pressure with engine by turning a dial to a rich side with descent of fuel pressure.
(f) Lamp Display Function

The red display lamp of an ECU and the display lamp on “Dial Controller” display the following information.

1. **The display of an injection signal input**
   
   An injection pulse will be inputted into ECU if engine is rotated using a kick pedal or a cell motor. When not engine starting, ECU performs “ON” and “Off” an information lamp at every input of a signal. If engine starts, this display function will be ended. You can know whether the function of a signal unit is normal by this display.

2. **Shift-Up Indicator**
   (*Dial Controller lamp only)
   
   The light is switched on when it becomes more than the engine rotation speed set up by control software (SWB).

3. **Injector wiring disconnection warning**
   
   The light is switched on when wiring to injector is disconnected. A lighting pattern is as follows.

   ![Lighting Pattern](image1)

4. **Pump wiring disconnection warning**
   
   The light is switched on when wiring to a pump is disconnected. A lighting pattern is as follows. (*Note 1 *)

   ![Lighting Pattern](image2)

5. **Battery voltage warning**
   
   The light is switched on when the voltage of a battery becomes low too much. (*Note 1 and 2*) A lighting pattern is as follows.

   ![Lighting Pattern](image3)
(6) **Warning at 100% duty cycle**

The light is switched on when the injection time exceeds time while a crank rotates two times. That is, it means that only injection time as set up cannot be injected. Usually, although it is thought that such a thing does not happen, when this display comes out and engine is turning at "Lean", it means that the injection capacity of injector is insufficient. A lighting pattern is as follows.

![Lighting pattern](image)

(7) **Setting map reading error warning**

ECU reads the map for control from a memory, when starting. This warning display is turned on when a map has an error. When this display comes out, a controller stops all control. When a warning display does not disappear even if it reboots ECU after transmitting the map saved at PC again, please contact us. A lighting pattern is as follows.

![Lighting pattern](image)

*Note1 Warning - Voltage & Pump*

**Pump wiring disconnection warning** and **Battery voltage warning** are detected only when the drive mode of a pump is "Pulse Drive". They are not detected when the drive mode of a pump is a PWM drive. (However, they are detected at the time of starting of ECU.)

*Note2 Battery Voltage Warning*

Battery voltage warning is turned on when it's voltage becomes less than 12volts. Usually, since it is normal that the battery is maintaining more than 12volts, when such a display comes out, please charge the battery promptly. Since it is thought that the pump drive cycle is too short (too much driven) when this display comes out frequently, I ask you to improve a pump drive setup. In addition, even when this display comes out, injection control does not stop. When it should become low voltage during a run, the fuel volume of injection decreases by the fall of the pump pressure. In this case, it is possible to run by turning a dial controller to a rich side and compensating the insufficiency of the fuel volume of injection.
"Tutorial of PC software [SWB]"

The setting value of ECUs, such as basic injection time and a compensation value, is set up by the control software "Setting Workbench For Windows" (the text after this describes "SWB") which operate with the personal computer (*Note1) of Windows (*Note2). Next, the outline of how to use this control software is explained.

*Note1) A serial port is required for the personal computer which uses SWB. When there is no serial port, we recommend you use of a USB serial conversion adapter.


(a) How to Install

Please double-click Setup.exe in the folder corresponding to each version of Windows. In Windows2000 and WindowsXP, please double-click Setting Workbench.msi. Please complete installation with reference to the message displayed on a screen.

The newest information about the combination of corresponding OS and setup file, and installation method are indicated on the label of a CD-ROM case. Please perform after a check.

*When you install, please be sure to end other applications.
(b) Outline of "SWB"

"SWB" mainly has the following functions.

1. **Edit "Basic Injection Time" Settings**  p2-11
   
   A setup of "basic injection time" is possible. It is possible to set the rotation speed axis and "throttle angle axis of the point which sets up "basic injection time", as arbitrary values. It is possible to multiply the whole setting map or arbitrary domains by a constant value.

   *In D-Jetronic, throttle angle axis changes intake pressure axis.*

2. **Edit "Compensation Table" Settings**  p2-22
   
   The table of the following compensation coefficients can be edited.
   - Warm-up Compensation
   - Start up compensation
   - Accelerate Compensation ( for *D-Jetronic only )

3. **Change Enable/Disable of Each Compensation**  p2-18
   
   You can set these compensation values to "1.0" quickly with each enable/disable property.

4. **Edit "Start-up Injection Time" Setting**  p2-24
   
   Setting of this function is also edited in the same window as edit of a compensation table.

5. **Edit "Asynchronous Injection Time" Setting**  p2-24
   
   Setting of this function is also edited in the same window as edit of a compensation table. You can stop "Asynchronous Injecton" quickly with enable/disable property.

6. **Edit "Fuel Cut Control" Setting**  p2-24
   
   Setting of this function is also edited in the same window as edit of a compensation table.

7. **Edit "Revolution Speed Limitter " Setting**  p2-21
   
   You can change R.P.M. value of revolution speed limitter.

8. **Edit "Shift-Up Indicator ( Information Lamp of Revolution Speed )" p2-21**
   
   You can set the rotation speed which an indicator lamp turns on as arbitrary values.
(9) **Edit "Pump Control" Setting**  p2-19

You can set up the pump control settings in "Pump Setting" window.

(10) **Change Enable / Disable of Dial Compensation of "Dial Controller"**  p2-18

You can disable the fuel injection time compensation dial of a dial controller. When you use this product without connecting a "Dial Controller", please set up "disable".

(11) **Edit "Hardware Configuration"**

The following setup can be changed in this window.
- Throttle bore and throttle sensor range.
- Injector flow rate (feed rate, cc/min).
- Idle Throttle position (%).
- Injector reaction period (injector dead time, msec).
- Dial Controller range.
- Intake pressure sensor (boost sensor) range.

*Since the item set up on this window is adjusted to the composition parts of this product[set], before shipping, you do not need to change those settings.

(10) **ECU Data Monitor**  p2-27

You can see the information in ECU using a "data monitor" function. An updating cycle is about 1 time in 1 second.

(11) **Read settings from ECU and save to the file**  p2-7, p2-9, p2-10, p2-26

A setup read from ECU can be saved at a file. Moreover, a setup saved at the file can also be sent to ECU.
(c) Start and Exit

Start "SWB"

Please click [Start] > [program] > [Setting Workbench]. It will start.

The 2nd "SWB" can be started when one "SWB" has started. For example, it is possible to edit a map etc., comparing the screen of two "SWB". However, since "SWB" does not take out warning to saving to the same file in this case, be careful of management of a file.

Exit "SWB"

SWB will be ended when "end" button in the window upper part is clicked, or X buttons at the right end of an upper end are clicked, or "Exit" of a "File" menu is clicked. At this time, since the message which checks saving to the file is displayed when the read data has change, please click "save" or "cancel".
(d) How to Set-up the Settings -- "Map"

The flow of the work in the case of changing a setup is explained.

After starting, setting data is empty in SWB. First, you need to read data from ECU or a file. In this time, you cannot choose any items other than "Open file" and "ECU >> SWB"

*(A) We recommend you to save the data read from ECU before editing as much as possible.

Next, you change the item of the purposes, such as basic injection time, compensation, pump setup, etc.

Then, you save data or transmit data to ECU. Keep in mind that change is not reflected in a setup in ECU until it "transmits."

*(B) We recommend you to save data before transmission at a file.

Since ECU reflects change in control immediately after transmission, there is especially no necessity of restart engine.

A changed setup is saved at ECU, when IG switch is cut (when ECU is turned off).

If the present setup is previously read from ECU before reading a setup from a file when changing a setup read from the file and sending to ECU, only a part with change will be transmitted. The function to transmit only a change part is convenient, when changing a setup and arranging it one after another.
You connect a personal computer with ECU by the attached communication cable first. Since the window of "COM PORT" opens when a "receiving" button is pushed, please set up a port number and click the "O.K." button.

A mouse icon becomes a sandglass display during reception, and SWB cannot be operated in the meantime. Reception takes about about 10 seconds. When the message of the completion is displayed after reception is completed, please click the "O.K." button.

The port number of a serial port can be checked with " system property" window of a personal computer.

Since SWB displays an error message when the wrong port number is set up, please click a [ECU>>SWB] button again after clicking [Tool] > [Option] of a menu bar and clicking the right number of the "COM PORT" and the "O.K." button.
If reception of a setup is completed, it will become a screen display as shown in the following figure.

ID of ECU and date of last update are displayed on a status bar.

*Transmission and reception of data with ECU are possible only at SWB corresponding to the version of each ECU. Be sure to use SWB set up from CD-ROM appended to the product, or SWB upgraded to the correspondence version.
(f) Read Settings from the File

If the "Open" button in the window upper part is clicked, the dialog of "Open File" will appear. Please select a setting file to open and click the button "Open." The extension of a setting file is .swp. When reading is completed and the message of "reading completed" will be displayed, please click [O.K.] button.

*A setup of hardware is saved at the setting file. The data received and saved from ECU with different ID cannot be transmitted.*
(g) Save Settings to the File

If a setup read from the file is changed or data is received, you can save those data at a file. ECU ID and last update of readed setting are displayed on a status bar.

A comment can be added to the file to save. For example, engine specifications, such as displacement volume, a setting place, the feature of a setup, etc. can be written in freely. When you click "File" > "Save As" from a menu bar, SWB displays the dialog box of a comment input.
(If you will carry out overwrite, please click "File" > "Save" of a menu bar.)

When this dialog box is displayed and it is going to save a setup read from the file, the comment in the file saved at origin is displayed on the window. In the case of the data read from ECU, it is displayed as "No Comment." Input a comment here freely and click the "O.K." button. Please click "O.K." to save with the comment currently displayed. Please click "Cancel" button, when a comment is unnecessary. In this case, a comment is saved with "No Comment."

If "O.K." or "cancellation" button is clicked in comment dialog box, the dialog box of "Save file" will be displayed. Please save file in arbitrary file names and folders.

You can check comment of current setting at "file comment" in the "Data Property" window, displayed on clicks "edit" > "property" of a menu bar.
(h) Edit "Basic Injection Time" Settings

* In the case of the D-Jetronic version, please read "the throttle angle" as "intake pressure."

How to change a setup of basic injection time is explained in this chapter. Basic injection time can be changed by the following two methods.

(A) The method of changing a value for every point set up by the engine rotation speed axis and throttle angle axis.

(B) The method of multiplying "Gain" to every domain of throttle angle.

(A) "Changing a value for every point"

If the tab of "Basic Map" is clicked, the screen of basic injection time will open. You can change a value in the form of the window lower part.

When you click button of "Edit RPM Axis" and "Edit Throttle Axis", the point of which you can edit "injection time" moves. Please move a point to which you want to set up. The current point is shown by blue circle.

If button is clicked, a point will jump to an axis of end.

Moreover, when you delete the axis which became unnecessary or you newly increase an axis between axes, please click button of each axis window.

The position of an axis can be adjusted with slider.

You can input a value directly to , and click "O.K." button. In this case, you need to input a value between neighboring axes.

Injection time settings of points in a plane at the selected R.P.M. axis are displayed on right side graph window. It will be good to set up referring to left side 3D display and right side 2D display.

You can change injection time with the slider , can also put a direct value into box , and push "O.K." button on "Injection Time" window.

*In the case of the D-Jetronic version, please read "the throttle angle" as "intake pressure."
When the point of graph has exceeded the maximum of a vertical axis in the result of editing injection time, please click "View" > "Standard View" of a menu bar. The maximum value of a vertical axis will be adjusted automatically. Moreover, if "View" > "Zoom In" of a menu bar is clicked, graph will be displayed zooming in low rotation speed and low throttle angle. This is convenient when changing an idol domain.

(B) Multiplying "Gain" to every domain

When you click the "Set by Gain" button of the "Input Method" window, the window that has many sliders for adjustment displays. Please adjust a window position so that a map display is in sight, as shown in the right figure.

(B-1) How to use multiplier "Gain"

The slider in a "whole Map Gain" window is used when multiply a value to the injection time of all points.

In the "Gain of Throttle Range" window, the values in the right side of "throttle %" are the throttle angle of the degree domain boundary, and the values under sliders are multiplier to the points in their domain.

The injection time of the points in a domain between the both boundaries are multiplied by the values which are calculated by values of both boundary using linear Interpolation.

A map shape changes with this adjustments on the graphs in main window. This change will be decided if "O.K." button is clicked.

Please click a "Cancel" button to cancel added change. It returns to the settings before a window is displayed.

When which button is clicked, a window is closed, and a bordering setting value etc. returns to a default. The "Gain" calculates based upon an injection setup before a window display as 1.0.
"Compensation"

Warm-up Compensation
(Engine Temperature Compensation)

This compensation is compensating the lack of fuel evaporation and increase in volume of air filled in engine when engine has got cold.

You can set the value to each temperature points up to 3.5. Usually, 1.0 or more values are set to the temperature of 70 to 80 degrees C or less.

Start up compensation

This is compensation which increases fuel after starting of engine until it carries out stable rotation. At the time of engine starting, a setting value is determined from the table of this compensation setup based on engine temperature. After starting reduces a compensation value at a fixed rate. Compensation is completed when a value is set to 1.0. You can set the value to each temperature points up to 3.5.

Reduction value of compensation is set in the lower side of compensation window.

There is switch in right side of window. When you click an upper switch, a reduction value increases. Thereby, the time to the completion of compensation becomes short. Conversely, if a lower switch is clicked, the time to a compensation end will become long. Graph expresses the compensation end time in display temperature and R.P.M.
**Start up injection time**

This is not a compensation value. It is injection time which will be injected in a period until it becomes a rotation speed stable. It is not based on the angle of throttle, and rotation speed, but fixed injection time is set up for every point of each temperature. Since evaporation of fuel runs short when engine temperature is low, injection time is increased.

**Asynchronous injection time**

Asynchronous injection is the function to perform compensation injection, when change of the intake air volume rapidly between the timings of synchronous injection. Asynchronous injection time is set up to the point of the amount of open angle change of throttle.

**Fuel Cut Control**

In engine rotation speed over idol speed, fuel injection is stopped at idle throttle position. Usually, it carries out from a rotation speed somewhat higher than idol rotation speed. Since it is easy to carry out a stole when engine has got cold, a higher rotation speed is specified. In a right figure, for example, at the engine temperature of 70 degrees C or more, when a throttle is an idol position in 3500r.p.m or more, fuel injection is stopped. In 23degree C, Injection is not stopped lower than 8000r.p.m.

This functions also as an idol R.P.M. limiter.
Accelerate Compensation (for *D-Jetronic only)

This function corrects a gap of the air/fuel ratio by the following reasons.

a) Response delay of intake pressure sensor.
b) The difference in the fuel evaporation by the intake pressure at the time of acceleration or a slowdown. (Throttle open or close)

When Throttle changes in the direction it opens, the volume of fuel is increased. Because engine is changing in the direction whose intake air volume increases and the value of a sensor is following behind time. Conversely, fuel is decreased when a throttle changes in the direction which it closes. Because intake air volume is changing in the direction decreasing and the value of a pressure sensor follows later than it. In this compensation, when a throttle changes, a value is set, and a value is increased or decreased gradually. Compensation will be ended if a value is set to 1.0.

You can set up the value to 0 to 5 times to the point of the throttle change speed of arbitrary acceleration or the slowdown direction.

The value to increase, or the value to reduce is set up in a lower window. It sets up with this button. If an upper button is clicked, it will come to return early, and if a lower button is clicked, it will come to return slowly.

It differs from the asynchronous injection which performs compensation injection temporarily that the volume of synchronous injection is increased or decreased between a certain set-up cycles.

"*D-Jetronic" is the registered trademark of Bosch AG
Among the control parameters in ECU, the following information can be displayed on the screen of PC by using the communication. Open rate of throttle, temperature of engine, value of dial controller, and rotational speed of engine, voltage of battery, and injection time

Please connect ECU with the PC with the communication cable.
Next, please operate "download from ECU" referring to the chapter of "Read Settings from ECU".
When the reception is completed, please click "Tool" >> "Data Monitor" of the menubar. The data monitor window is displayed.
When "Start" button is clicked, it starts displaying.

The raw data of the sensor is displayed in the left, and the converted physical quantity is displayed in the right. An open rate of the throttle is converted into an open area rate of throttle boa. The open rate of the throttle used in the basic injection map is this open area rate.

In throttle open rate and engine temperature, PC converts into a physical numerical value when the engine speed is zero, and displays them by a red character. When the engine starts rotating, the value in which the conversion calculation is done with ECU is displayed in blue.

* Even if the dial controller's setting is "diabled", the numerical value displays the value of the dial.
* After engine starting, some parameters are displayed in red character.
Other operations of SWB cannot be done while receiving the timer.

A right graph displays the position of referred map. The graph can be cleared with the button of "Graph Clear".

After the "communication" is stopped by "stop" button, the window can be shut with the "Close" button.

"Aria Percentage" is changed "Manifold Pressure".
(3) configure and sensor adjustment

Before use, it is necessary to do "Hardware Configuration" and "Map Adjustment" after ECU is installed to the vehicle. These settings are usually set when "FC design" ships it. However, the thing that shifts by engine vibration the idle adjusting etc. is expected. This chapter explains these adjusting methods.

The set item.

As a hardware configuration.
1. Setting of close values and full open value of throttle sensor.

As an adjustment of the map.
3. Adjustment by capacity of injector and displacement of engine.

[Setting of close values and full open value of throttle sensor.]

ECU must convert from the voltage of the throttle sensor into an open rate of the throttle and refer to the jet map.
The setting to which open rate the voltage of the sensor hits changes according to the installation position of the sensor and the operation angle of the throttle valve.
It has usually adjusted it in "FC design" before ECU is shipped. However, it is likely to shift the overhaul of the throttle body or caused by loosening of the installation by the vibration under use. We will explain the method of adjusting this value here.

(i) Read Full Open Value

At first, please operate starting "Data monitor" (refer to "Data Monitor Window" chapter).
Open the throttle to the wide(full open) limit when click "Start" button, the communication begins. Afterwards, please read the value of the throttle sensor (value of 0-255).
If the value is 255, please loosen the sensor installation screw of the throttle body, and adjust to become a value that is smaller than 254 while seeing the sensor value of Datamonitor.
(ii) Read Full Close Value

In the same way, please read the value at full close position. At this time, please rotate the idle adjustment screw until becoming a position in which not the idle position but the throttle is completely closed. Please read the value at the position in which the throttle is completely closed.

(iii) Set Value to PC

Next, please set the sensor value to ECU, according to the following methods. Please return to the main window, and click "Tool" >> "Hardware configuration" of the menu. opens.

When the message is displayed, click "Continuation" button, please. "ECU Configuration" window The value is set to the frame of "Throttle body" on the left top of the window. Please input the sensor value of full open throttle to the box of "Sensor value of full open". When the button of "Manual" in the right of the box, "Sensor value of close" is clicked, the input window opens. Please input the sensor value of full close throttle here, and click the "OK" button. When the message of "Value is incorrect" is displayed, the input value may be wrong, please try again from the step, "the full open value".

The input of "Throttle Diameter" is arbitrary. Please use it as a memo of the setting (Map).

(iv) Transmit to ECU

Please confirm the connection of the communications cable, confirm the power supply of ECU is turning on, and click the "PC >> ECU" button. The mouse icon becomes an "hourglass" display while transmitting, and meanwhile, SWB cannot be operated. It takes about ten seconds to transmit. The message of "Complete" is displayed when the transmission is completed and click the "OK" button, please. The power supply is turned off. ECU maintains the power supply while writing the setting, and the power supply cuts afterwards.
"Fi" Fuel Injection System
Electronic Control Unit
Instruction Manual

May, 2001 First edition issue
January, 2003 Ver.4
February, 2006 Ver.4 English(Under translation)

FC Design Co.,Ltd.
2-1-48-1F, Honmachi, Fuchucho, Akigun,
Hiroshima, Japan post code 735-0006
Tel +81-82-287-0211
Fax +81-82-287-0212
http://www.fc-design.com
E-mail:info@fc-design.com

Copyright (C) fc-design